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1 Introduction

1.1 AnyCount 7.0

AnyCount is a text count software, designed to count text volumes in words, characters, lines and
custom units in multiple files of different formats. 

1.2 Using this Guide

AnyCount User Guide (further referred to as "Guide") is aimed at general AnyCount user audience.
Note, that for some operations user must have administrative rights.

 Note: Notes, like this, highlight text which requires additional attention. 

Disclaimer

Like any other software product, AnyCount is constantly changing. The program is being reviewed,
upgraded, enriched with new features. Advanced International Translations, Ltd. reserves the right to
implement any changes to the product, described in this guide, without prior notification.

AnyCount is a registered trademark of Advanced International Translations, Inc. Names of any other
products or companies mentioned or referenced to in this Guide are registered trademarks of their
respective owners. 

1.3 Reference Material

Additional information on AnyCount operation can be found in the following sources:

Help Materials

· AnyCount Help System – press F1 key when AnyCount is open to access AnyCount help.

· AnyCount Online Help – to open online help in your default web browser, use the following link:
http://www.anycount.com/OnlineHelp_V7/index.html

Documents

· AnyCount Quick Start Guide – a guide to quickly start working with AnyCount.  To download this
document, use the following link:

· Text Count in AnyCount 7.0 and MS Office – a comparison table, which shows in detail, which
elements for which formats can be counted by AnyCount and MS Word 2003, MS Word 2007. To
download this document, use the following link: http://www.anycount.com/
TextCountComparison_V7.pdf

· AnyCount FAQs – summary of most frequently asked questions about AnyCount, and answers to
them. To download this document, use the following link: http://www.anycount.com/
AnyCountFAQ_V7.pdf 

· AnyCount Settings – reference description of AnyCount settings which configure which elements
should and should not be included in total file count. To download this document, use the following
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link: http://www.anycount.com/AnyCountSettings_V7.pdf 

Web-sites

· http://www.anycount.com – general resource, containing brief and detailed program description and
downloads.

· http://www.aithelp.com/AnyCountSupport – support portal with document downloads,
troubleshooters, knowledge base and customer support contacts.
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2 Setup

2.1 System Requirements

AnyCount can be successfully installed and run on any PC conforming to the following
specifications:

Hardware and Software Requirements

Operating System Windows 98

Windows ME

Windows 2000

Windows XP

Windows 2003

Windows Vista

CPU 300 MHz or higher

Memory 128 MB or more

Hard Disc Space 10 MB

Monitor Any  VGA/SVGA  monitor  with  support  for
minimum of 800x600 resolution and 256 colors 

2.2 Installation

To install AnyCount:

1. Download latest AnyCount setup using one of the following links:

http://download.anycount.com/AnyCount7Setup.exe

http://download2.anycount.com/AnyCount7Setup.exe

2. Run AnyCount setup file, and proceed with setup Wizard steps.

 Note: Ensure that you have administrative access rights before installing AnyCount. If you do not
have administrative access rights, please contact your local system administrator. In order to run
correctly, AnyCount requires write access to the folder in which the program is installed.
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3 Working with AnyCount

3.1 Overview

Text count procedure in AnyCount consists of three general steps: selecting files, configuring count
settings, and counting. These three steps can be accessed with the help of three buttons at the bottom
of AnyCount window:

 Note: Files can also be added to queue by right-clicking them, then on the context menu clicking
Add to AnyCount command.

3.2 Selecting Files to Count

Selecting Files with Windows Context Menu

The quickest way to count a few files is to use Windows context menu. 

To quickly add and count files:

1. Right-click appropriate file. 
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2. In the context menu click Add to AnyCount and Count command to count these files at once. 

3. AnyCount will run, and start counting.

To quickly add files to count queue:

1. Right-click appropriate file. 

2. In the context menu click Add to AnyCount command to add selected files to AnyCount
queue. 

3. Repeat the procedure with the rest of required files.

 Note: You can select and count multiple files. Folders cannot be added to count queue this
way.

Selecting Files from within AnyCount

In case you need to count large number of files, or if you need to add folders with files, it is better
to add the files from within AnyCount.

To add files to count queue:

1. Run AnyCount. If your AnyCount is already running, click Files button to begin adding files.

2. Click  Add button in the AnyCount window. Add Files window will be displayed. 
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Click  Remove button, to remove currently selected file (in case some files were added
previously, and must not be included in current count).

Click  Clear button to delete all previously selected files from counting queue. Use this button
to quickly clear long queues.

3. Select necessary files or folders to be counted, then in the Add Files window click  Add
button. Newly added files will be displayed on the Selected Files field at the bottom of the window.

To remove files or folders from counting queue, click  Remove button. To display only those
files, which are compatible with AnyCount, select Compatible Only check box.

 Note: To select multiple files or folders, press and hold Ctrl key on your keyboard, then click
each of the files or folders one by one.

 Note: If you have direct folder address, paste it into address field, then click GO > button.

4. After all necessary files and folders have been selected, click OK. AnyCount will begin adding
files to count queue. Once all the files have been added, they will be sorted by file type. 
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 Note: Adding large numbers of files may take additional time.

5. Click Count! button, to begin counting currently selected files right away.

3.3 Count Settings

After files and folders have been selected and added, click Settings button to adjust common and
format specific count settings.

Settings in AnyCount determine which objects should or should not be included in count results. 

Common Count Settings

There is a group of settings that are common for each format. The following common settings can
be changed on the Common tab of Settings window:
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· Skip Numbers – do not count numbers.

· Show Full Path – display full path to location of the file which is counted.

· Force re-count of previously counted settings – count all files in the list regardless of
whether they have already been counted or not. Disabling this option will make the program
count only newly added files, ignoring the ones which have been already counted.

Format-Specific Count Settings

There is also a number of format-specific settings. You can adjust these settings separately for
each file format, by clicking respective tab.

Example 

3.4 Count Units

Before starting counting process, ensure that you select right count units. These can be characters
with spaces, characters without spaces, words, lines, pages or your own count units. Currently
selected count unit is displayed in the bottom right corner of the AnyCount window.

To change count unit, click drop-down list at the bottom right corner of AnyCount window. 
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To create your own count unit, click Customize... button at the bottom right corner of AnyCount
window. 

Customize Count Units window will be displayed. Click New button, to create new count unit.
You can also edit existing count units by clicking Edit button. 

All count units (pages, lines) are derived from three basic atomic values:

· words

· characters with spaces

· characters without spaces.

Example 

You need to count text according to Belgium count standard, which is 60 characters per line.
There is no such default unit, so you will need to create a new unit for Belgium lines:
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3.5 Count Results

After counting is completed, results will be displayed in the table. AnyCount sorts count results by
corresponding file formats, thus there can be several tabs for each group of files.

Summary tab displays general results for all the files which have been counted. Select Detailed
Summary check box, to display additional columns (like numbers, shapes, embedded objects,
and so on).

Export Count Results

To export count results, click Export button on the corresponding tab.
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You can export the results to HTML, DOC, RTF, CSV, TXT and PDF file formats.

Configure Table Layout

You can sort results in columns by clicking header of the corresponding column. You can also
customize how the table with count results is displayed. 

To add or remove columns: 

1. Right-click on the table. 

2. On the context menu click Customize columns... command. 

3. Select or clear check boxes to display or hide respective columns.
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Vertical View

To view summary of selected row in results table:

1. Right-click on the table. 

2. On the context menu click Vertical view.
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Copy and Print Count Results

Count results can be pasted into some other documents through clipboard, or sent to printer. 

To copy table with count results to clipboard, click Copy to Clipboard button. 

To print results, click Print button. 

 Note: You can view results in different count units using the drop-down list in the bottom right
corner of the Count window. Select a different unit to immediately view count results in that unit.
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4 FAQ, Troubleshooting and Support

4.1 Frequently Asked Questions

4.1.1 AnyCount Licenses

Q: How to purchase AnyCount license?

A: We use several billing partners with multiple payment methods.

ShareIt!

You can purchase AnyCount license online using the link below:

http://www.anycount.com/order.html

ShareIt! supports Credit Card, Wire transfer – prepayment, Check – prepayment and Cash –

prepayment methods.

PayPal

If you have PayPal account, use the following link to order AnyCount:

http://www.anycount.com/order.html

Select PayPal option when ordering

Moneybookers

Pay to Volodymyr Pedchenko at vladimir@translation3000.com and forward your payment receipt with
the help of the following web form:

http://www.aithelp.com/submit_ticket

WebMoney

Pay to WMID: 618042351503 (Vladimir Pedchenko, Advanced International Translations) and forward
your payment receipt by using the following web form: http://www.aithelp.com/submit_ticket

Our WM wallets:

Z470586755282

R123626207214

E067506349467

U312517239928

Contact us at AnyCount Support Department if you have any questions about other payment types.

Q: What should I do if I lost my license key?
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A: You can always download your license keys from your personal profile at AIT Client Relationships
Portal: http://clients.translation3000.com/

Use your registration e-mail and password to log in. Registration e-mail is the e-mail which you
indicated in order form when purchasing the license.

If you cannot log in to AIT Client Relationships Portal, use the following web page to contact AIT
support team. Indicate your purchase ID or registration name and e-mail, so that we can find your
account record:

http://www.aithelp.com/AnyCountSupport

Q: Do I have to purchase new license if I reinstall AnyCount on new PC after
the old one crashed?

A: No, you do not have to purchase new license, you can freely use your original license. License key
is not tied to any particular installation of AnyCount on physical PC.

Q: Do I have to purchase new license if I need to install AnyCount on my
second PC?

A: No, you do not need to purchase new license. You can legally install AnyCount on another PC (or
laptop) using the same license key, provided that you will be the only user of the program.

Q: Do I have to register for a trial version?

A: You do not need to register. You will have 30 days of trial use starting from the day of the first
installation (not from the first day you run the program). Reinstalling will not reset the trial period. 

4.1.2 Compatibility

Q: Is AnyCount compatible with Windows Vista?

A: Current version of AnyCount is fully compatible with Windows Vista. Unfortunately, earlier
versions, AnyCount 5.0 and AnyCount 4.0 are not.

Q: Is AnyCount available for Macs?

A: No, there is no Mac version. Currently, there are no plans to release a Macintosh version of
AnyCount in the nearest future.

Q: Does AnyCount support MS Office 2007?

A: AnyCount 7.0 supports MS Word 2007, MS Excel 2007 and MS PowerPoint 2007 file formats.
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4.1.3 AnyCount Settings

Q: What does "Shapes" mean within the AnyCount settings?

A: AnyCount counts text contained in Shapes in MS Office files. Shapes represent elements that
belong to auto shapes like WordArt, ClipArt elements. Commonly, shapes can be inserted with the
help of AutoShapes feature in MS Office Word. More information about shapes you can find in
Microsoft Office Online Help.

Q: What do “Slide Master”, “Note Master”, “Handout Master” and “Title Master
” settings mean when counting .PPT files? Why do they have the same number
of text units?

A: Slide Master is a part of presentation template. It controls the overall formatting and object
placement for the presentation. Note Master, Handout Master and Title Master response for the
corresponding Note, Handout and Title templates. To view these masters, click Master in the View
menu. You will see that masters contain the same amount of text.

As a rule, there is no need to count Slide Master, Note Master, Handout Master and Title Master. So,
you can switch off these settings if you do not need to translate them. More information in Microsoft
Office Online Help.

4.1.4 Text Count in AnyCount

Q: Does AnyCount count footers, headers, notes, text in embedded
documents, etc.?

A: AnyCount can count footers, headers, notes, footnotes, end notes, text boxes, shapes, text in
embedded and linked documents, comments and hidden text. You can optionally exclude these
elements from count results.

Q: How can I count text on website?

A: AnyCount is able to count text in HTM (HTML) files. To count text on particular website you need to
do the following:

1. Download website you need to count. On the File menu of your Internet browser click Save
command.

2. Run AnyCount.

3. Add pages for counting.

4. Click Count! button.

You will see statistics for each page and total amount of text.

Q: How many files can AnyCount count at a time?

A: AnyCount 6.0 has been tested with 50 000 files being counted at a time. System properties for the
test computer:

Pentium 4, CPU – 3 GHz, RAM – 2 GB
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Note, that if the files for counting are located on the network drive, this may slow down the process.

Q: Why there is a difference between MS Word Word Count feature and 
AnyCount results?

A: The main reason for this difference is that AnyCount does not count text format elements (e. g.
bullets). Text format elements mark the content being only the result of formatting. MS Word counts all
these elements.

MS Word 2003 does not count headers, footers, comments, hidden text, etc., while AnyCount does
count them, if all necessary settings have been set. More information about text count differences in 
MS Office Word and AnyCount can be found in the following comparison table:

http://www.anycount.com/TextCountComparison_V7.pdf

Q: Can AnyCount omit/count numbers in text?

A: Using Skip Numbers option you can perform counts omitting or counting numbers.

4.1.5 Technical Specific Issues

Q: Why does AnyCount require administrative rights?

A: Administrative privileges are required only for installation of AnyCount, and no special requirements
to the access rights needed for using the program.

Q: Can AnyCount be integrated in other third-party application?

A: AnyCount is designed mainly for translators needs as Windows application. AnyCount does not
have an API to be integrated into other applications.

4.2 AnyCount Troubleshooter

# Problem Solution

1

AnyCount does not count
MS Office files (DOC,
DOCX RTF, XLS, XLSX,
SDW, SXW, SXC, PPT,
PPTX)

A. Make sure that you have MS Office installed on your
computer. If you do, try reinstalling MS Office.

B. Make sure that your MS Office files do not contain too
complex embedded files.

2

AnyCount does not count
OpenOffice files (ODT,
ODS, ODP)

Make sure that you have OpenOffice installed on your
computer. If you do, try reinstalling OpenOffice.
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3

AnyCount shows error
message “Number of
files cannot be more
than 10”

You have 30 day trial version of AnyCount with the
limitation on file queue length (10 files maximum). Please,
buy full version of AnyCount to remove this limitation.

AnyCount license can be purchased online at http://www.
anycount.com/order.html.

If you have already purchased AnyCount, please enter
your AnyCount license key: on the Help menu click
Register.

4
AnyCount shows error
message “License key
is damaged: Error #23”

Error #23 appears when your license key is not compatible
with your current version. Currently there are three
versions available: 5.0, 6.0, and 7.0 (current). Version of
your license key is displayed in AnyCount key file, which
you received after purchase. 

You can download correct AnyCount version from the
following web page: 
http://www.aithelp.com/AnyCountSupport.

5
AnyCount shows error
message “Class not
registered...”

A. This error message may appear when one of MS Office
applications has not been installed or registered correctly.
For example, it is possible that you encounter problems
when counting .doc or .rtf files. In this case you have to
reinstall your MS Office Word.

B. Try registeting your MS Office 2003 application:
1. On the Windows Start menu click Run.
2. In the Run window enter cmd command to open
command line dialog.
3. In the command line window enter cd c:\Program Files
\Microsoft Office\OFFICE11 (or enter other pathway where
your winword.exe file is located).
4. Enter winword.exe /regserver.
This command will register MS Office Word in the system
registry (procedure normally done during installation).

6
AnyCount shows error
message “Interface not
supported”

A. You do not have corresponding application installed. (e.
g. you count .ppt files but, there is no MS Office Power
Point installed on your PC).
In this way you have to install corresponding software first.

B. You have an old version (AnyCount 4.0, AnyCount 5.0),
which does not support MS Office Word and Excel 2007,
latest versions of Adobe Acrobat Reader, etc.

C. One of your MS Office applications has not been
installed or registered properly.
For example, it is possible that you encounter problems
when counting DOC or RTF files. In this case you have to
reinstall your MS Office Word.
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7

AnyCount shows error
message “This file is
being used by another
application or another
user (C:\...\Normal.dot)”

Normal.dot is global template in MS Office Word. It can be
corrupted by some add-on programs or macro viruses.
Perform full system scan on any viruses first.

You can also temporarily rename the global template to
determine if it is the cause of the problem.

To rename the global template file follow these steps.
1. Quit all instances of Word, including WordMail.
2. On the Windows Start menu click Find, and then click
Files or Folders.
3. In the Named box, type the global template name for
your version of Word (Normal.dot).
4. In the Look In box, select your local hard disk drive (or
an alternate user template location if you are running
Word from a network server).
5. Click Find Now to search for the file.
6. For each occurrence of global template that appears in
the Find dialog box, right-click the file and then click 
Rename.
Give the file a new name, such as OldNormal.dot or
Normal-1.dot.
7. Minimize the Find dialog box.
8. Restart AnyCount.

8

AnyCount shows error
message “Some errors
occurred. See Details
tab”

If you see “Unable to create a filtered stream” message
on the Details tab, then the file you try counting is
protected with the password. AnyCount can not count
protected files.

9
AnyCount does not
count XML files.

A. If AnyCount displays zero results for XML file counting,
make sure that the file contains text between XML tags.

AnyCount counts text between tags only.

B. If you have some errors when counting xml files, it is
possible the structure of the file is incorrect. Note that
general structure of any XML file should be as follows:

<open tag>Countable Text</close tag>

Make sure that <open tag> or </close tag> is not omitted
or duplicated.

C. There can be also an invalid character which causes
the problem. As a rule, AnyCount displays the line, where
the problem is occurred. Open your XML file with any tag
editor software or Notepad and try deleting that invalid
character.
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10
AnyCount does not start
or freezes when starting

It is possible that application is blocked when
automatically checking for updates in the Internet at start
up. Make sure, that AnyCount is added to the trusted
programs list of you firewall or antivirus software. If you
use proxy server, ensure that its connection settings are
properly configured.

11
AnyCount freezes when
adding files

A. Make sure that the file to be counted is not located on a
network drive. Speed limitation of network connection can
cause AnyCount to freeze. Move the files to local drive
and then add them again.

B. Try the following solution:
1. Open (using Notepad) AnyCount.ini file from your
AnyCount folder (by default, C:\Program Files\AnyCount)
2. Delete the line starting with BrowseDir, save the file.
3. Restart AnyCount.

C. If you have Windows Vista installed, turn off UAC (User
Account Control).

12
AnyCount freezes when
counting

The file to be counted contains too many embedded
tables, graphics, images, diagrams, and so on. Try
simplifying the file by removing these elements.

4.3 Customer Support

If you have any questions, or problems with AnyCount, which are not covered in this guide, AnyCount
Help System or other documents listed in Reference Material topic, please use Advanced
International Translations help and support portal for latest updates, knowledge base articles and
customer support contacts.

· AIT Support portal can be accessed with the help of the following link:
http://www.aithelp.com

· AnyCount section of http://www.aithelp.com can be accessed with the help of the following link:
http://www.aithelp.com/AnyCountSupport 

To quickly open this page in your default browser, on the Help menu click Technical Support
command.

Use the web form on http://www.aithelp.com/AnyCountSupport to contact AnyCount support, All
queries are usually answered within 12 – 24 hours on business days.
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5 Glossary

Alt text
Alt text is an attribute that provides alternative text when non-textual elements, typically images cannot
be displayed for some reason.

Cell comment
Cell comment is a note that explains or gives remarks to a cell in a table. Often used by editor and
corrector staff.

Comment
Comment is a note that explains some part of text or gives remarks. These are often used by editor
and corrector staff.

CSV
Comma-separated values – file format for encoding basic tables through list of cell contents,
separated with delimiter symbols (usually comma or semicolon).

Delimiter
Delimiter is a symbol which indicates end of cell or column in CSV files.

Embedded object
Embedded object is a file which is inserted into destination file you have to count. Once embedded, the
object becomes an integral part of the destination file.

End note
End notes can be placed at the end of a document or section. As a rule such end notes can be found
at the end of a book.

Footnote
Footnote is a text placed at the bottom of a page. Footnotes are used to explain or comment some
part of the text indicated by a symbol or character.

Form controls
HTML form controls are buttons, input boxes, radio buttons, etc.

Handout master
Handout master defines how handouts will look when printed in PowerPoint or other presentation
editors.

Linked object
Linked object is similar to embedded object, the only difference is that linked file does not become a
part of target file, and can be accessed separately. All changes made in source file, will be displayed in
destination file.

Markup
Within the AnyCount settings, markup means comments inserted in the VSD (Visio) document.

Meta description
Meta description tag is a hidden HTML tag that allows some search engines to display a description of
your site in search results.

Meta keywords
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Meta keywords tag is an HTML tag which can be used to explicitly tell a search engine what the page's
keywords are.

Note master
Note master stores information on slide notes layout in PowerPoint or other presentation editors.
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Page footer
Footer is a small text identifier which runs through bottom of the document page.

Page header
Header is a small text identifier which runs through the top of the document page.

Shape
Shapes are elements that belong to "auto shapes" like WordArt, ClipArt elements.

Slide master
Slide master stores information about template design, such as style, placeholder and color in
PowerPoint or other presentation editors.

Slide notes
Slide notes give additional information or explain slide contents in PowerPoint or other presentation
editors.

Text box
Text box is a special shape designed to locate a text in a document without the use of regular margins
of the page.

Text qualifier
Text qualifier separates text from code in CSV files.

Title master
Title master stores information on title slides layout in PowerPoint or other presentation editors.
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6 Supported File Formats

AnyCount supports the following file formats:

 

Icon Extension Description

DOC 
Microsoft® Word for Windows,
Microsoft® Word for Macintosh, other
word processors

DOCX Microsoft® Word 2007 for Windows

RTF
Microsoft® Word for Windows,
Microsoft® Word for Macintosh, other
word processors

WPD WordPerfect

XLS Microsoft® Excel

XLSX Microsoft® Excel 2007

CSV
Microsoft® Excel, other spreadsheet
software

PPT, PPS Microsoft® PowerPoint

PPTX Microsoft® PowerPoint 2007

HTML,
HTM

Hypertext Markup Language file format

ODT

OpenOffice.org Writer, StarOffice
Writer, KOffice, Google Docs,
NeoOffice, Zoho, IBM Lotus
Symphony, Corel WordPerfect Office
X4

SDW
 StarOffice Writer (StarOffice 5.x),
OpenOffice.org Writer

SXW StarOffice Writer (StarOffice 6.x)

ODS

OpenOffice.org Calc, StarOffice Calc,
KOffice, Google Docs, NeoOffice,
Zoho, IBM Lotus Symphony, Corel
WordPerfect Office X4

SXC
StarOffice Calc (StarCalc 6.x),
OpenOffice.org Calc

SDC StarOffice Calc (StarCalc 5.x)

ODP

OpenOffice.org Impress, StarOffice,
KOffice, Google Docs, NeoOffice,
Zoho, IBM Lotus Symphony, Corel
WordPerfect Office X4
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SXI OpenOffice Impress

SDD StarOffice Impress 

CHM Microsoft® HTML help format

HLP Microsoft® Winhelp format

PDF
Adobe® Acrobat and Adobe® Acrobat
reader

XML
Extensible Markup Language file
format. 

TXT Various word processors

ZIP

PKZIP, WinZip, BOMArchiveHelper,
KGB Archiver, PicoZip, Info-ZIP,
WinRAR, IZArc, 7-Zip, ALZip, TUGZip,
PeaZip, Universal Extractor and Zip
Genius, etc.

RAR
WinRAR (Windows version), RAR
(Linux, Mac OS X, DOS, OS/2, and
FreeBSD versions)

SLP
Sisulizer – Visual Software Localization
Tool. More information can be found at 
http://www.sisulizer.com

PUB Microsoft® Publisher 

VSD Microsoft® Visio

BMP Bitmap image (various graphic editors)

JPG
Joint Photographic Experts Group
standard (various graphic editors)

PNG
Portable Network Graphics (various
graphic editors)

GIF
Graphic Interchange Format (various
graphic editors)
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